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Ba sic G IS  Traini ng –  V i e w i ng Data 

QGIS Download ရယခူြင ်း 

Window version QGIS က ို ၎င ်း၏ တရ ်းဝင  download website ခြစ သ   

https://www.qgis.org/en/site/forusers/download.html မ ှ ရယူန ိုင ပါ ည ။ အခြ ်းသ   Operating System 

မ  ်းအတကွ  https://qgis.org/en/site/forusers/download.html တွင  ကကည ့်ရှုပပ ်း ရယူထည ့် ွင ်းန ိုင ပါ ည ။  

The Open Source Geospatial Foundation http://www.osgeo.org မှလည ်း အခြ ်းသ   free software မ  ်းနှင ့် 

အတူတကွ ရယူန ိုင ပါ ည ။ ၎င ်းတွင  Desktop software, web mapping software နှင ့် လ ိုအပ သ   Library မ  ်း 

အစရှ  ည ့် free software မ  ်း ပါရှ ပါ ည ။ OSGeo Live မ ှInstall ခပြုလိုပ လျှင ၊ Internet connection သနှ်းပါက၊ အရင ဆ ို်း 

Computer   ိုို့ Package က ို Download ခပြုလိုပ ပပ ်း၊ Install From Computer နည ်းက ို   ို်းပါက ပ ို၍အဆင သခပပါမည ။ 

http://live.osgeo.org/en/index.html တွင  အြမ ့် ရယူန ိုင ပါ ည ။ 

 

QGIS Software Installation ခပြုလိုပ ခြင ်း 

32 bit Window Computer မ  ်းအတကွ  QGIS-OSGeo4W-3.10.3-3-Setup-x86 က ို Install လိုပ လ ိုက ပါ။ 

64 bit Window OS Computer မ  ်းအတကွ  QGIS-OSGeo4W-3.10.3-3-Setup-x86_64 ခြင ့် Install လိုပ လ ိုက ပါ။ 

အခြ ်းသ   Free and Open source software မ  ်းနှင ့်အတူ အတွ လ ိုက  စ ိုလင စွ  တစ ြါတည ်း install ခပြုလိုပ ြ င ပါက 

Package အလ ိုက  ထည ့်သပ်းန ိုင  ည ့် installer ြ ိုင  Osgeo4w-setup-x86.exe က ိုလည ်း အ  ို်းခပြုန ိုင ပါ ည ။ 

Install လိုပ ပပ ်းပပ ဆ ိုရင  စ  ို်းလ ိုို့ရပါပပ ။ 

 

QGIS က ို အြငွ့် အပ တ  ခပြုလိုပ ခြင ်း 

Window > All programs > QGIS 3.10 က ို ွ ်းပပ ်း QGIS Desktop 3.10.3 က ို Double-click ခြင ့် ြွင ့်လ ိုက ပါ။ 

QGIS က ို မ မ  Install ခပြုလိုပ စဉ က သရ ်းြ ယ တ ်းသ   အခြ ်း optional software မ  ်းနှင ့် အတူ သတွွေ့ရပါမည ။  

Shortcut တွင  အပမ တမ ်း ပါရှ သနမှ  ကသတ ့် QGIS Desktop version န ို့ QGIS Browser version တ ိုို့ခြစ ပါ ည ။ 

ကွ ခြ ်းြ က က  

QGIS Browser version က GIS ြ ိုင  အမ  ြု်းမ  ြု်းရ ွေ့ metadata, Attribute န ို့ Preview ြွင ့်ကကည ့်ရ ို   ရန ိုင ပပ ်း QGIS Desktop 

version က ြန တ ်း Create, edit, visualize, analyze and publish geospatial information စတ ့် GIS အလိုပ မ  ်းက ို 

ခပြုလိုပ ြ ိုို့ခြစ ပါတယ ။ 

 

https://qgis.org/en/site/forusers/download.html
http://live.osgeo.org/en/index.html
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QGISDesktop ၏ GUI Interface နှင ့်စတင  မ တ ဆက ခြင ်း 

 
 

QGIS GUI တွင  အပ ိုင ်း ၅ပ ိုင ်းပါရှ  ည ။ 

1 - Menu Bar 

2 - Tool Bar  

3 - Map Legend က Layer အတွက  

4 - Map View က သခမပ ိုက ို လ ခပမည ့် သနရ  

5 - Status bar က တည သနရ  နှင ့် စသက်း စ ည ့် အပ ိုင ်းတ ိုို့ ပါဝင ပါမည ။   

 

ဒ အပ ိုင ်းက ို ရှင ်းခပြ ိုို့ရန  အတွက  သခမပ ိုတစ ြိုန ို့ ရှင ်းခပရင  ပ ိုပပ ်းသတ ့် ရှင ်းရှင ်းလင ်းလင ်းန ို့ န ်းလည လွယ မယ ။ 

ကမ္ ့်န ိုင င မ  ်းပ ိုက ို အရင ဆ ို်း ြွင ့်ထ ်း သပ်းကကည ့်လ ိုက ပါ။ ပပ ်းရင  ဒ အပ ိုင ်းက ို ခပန လ ြ ့်ပါ။ 

Menu bar မှ  QGIS software ရ ွေ့ အဓ က feature သတွန ို့ Project နှင ့် က ဆ ိုင သ   အရ မ  ်း၊ Layer 

နှင ့်ပတ  က သ   အရ မ  ်းက ိုလ ိုအပ  လ ို Manage ခပြုလိုပ န ိုင ရန ၊ ြ ိုင  အ ွင ်း၊ အထိုတ ၊ ခပင ဆင  တည ်းခြတ ခြင ်း၊ (input 

၊ output ၊ editing) ၊ Settings၊ Plugins မ  ်း စ ည တ ိုို့ ပါရှ ပါတယ ။ 

Toolbar  ည  Menu bar ဆင တူပပ ်း၊ အဓ ကကသတ ့်Tool သတွ န ို့ ၎င ်းရ ွေ့ လိုပ သဆ င ြ က တ ိုို့ပါရှ ပါတယ ။ 

သဒတ မ  ်းက ို Analyze လိုပ ြ ိုို့ ၊ Process လိုပ ြ ိုို့ ၊ သခမပ ိုနှင ့် အခပန အလှန  ဆက  ွယ ြ ိုို့ အတွက လည ်း ပါရှ ပါ ည ။ Toolbar 

န ို့ Menu bar မှ ပါရှ သ   အစ တ အပ ိုင ်း တစ ြိုခြင ်း၏ အသ ်းစ တ က ို QGIS Maunal တွင  အက ယ တဝင ့် ဆက လက  

ကကည ့်ရှုပါရန ။ 

Status bar က သခမပ ိုရ ွေ့ စသက်း၊ projection system ၊ သခမပ ိုသပေါ်မှ  တင ထ ်းတ ့် Mouse Pointer ရ ွေ့ Coordinate 

တည သနရ  စ ည တ ိုို့က ို သြေါ်ခပပါ ည ။ 

Layer တစ ြိုသလ က  ထည ့်ပပ ်းတ ့်အြါမှ  နမူန    ို်းခပပါမယ ။ လ ိုြ င တ ့် Button သပေါ်မှ  Mouse က ိုတင ပပ ်းသတ ့် 

click လိုပ လ ိုက ရင  Tool က ို သရ ်းပပ ်း  ်း ခြစ သနမယ ။ လွယ ကူစွ  သလ့်လ အ  ို်းခပြုန ိုင ပါတယ ။ 
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အ  ို်းခပြုရန  လ ိုအပ တ ့် Toolbar သတွက ို အနည ်းငယ  မ တ ဆက သပ်းပါမယ ။ 

Toolbar တစ ြိုက ို Turn On/Off ခပြုလိုပ ြ င ပါက Menu bar > View menu > Toolbars က ို ွ ်းပပ ်း Tick ခြင ့် 

ြွင ့်ခြင ်း/ပ တ ခြင ်း ခပြုလိုပ န ိုင ပါ ည ။ Tick လိုပ တယ ဆ ိုတ က အမှန ခြစ သလ်း သပေါ်သအ င  check လိုပ တ က ို ဆ ိုလ ိုတ ပါ။ 

 

 
 

သန က တစ နည ်းကသတ ့် Toolbar သတွက ို QGIS ရ ွေ့ Menu bar သပေါ်မှ  Right-click တင ပပ ်းသတ ့်လည ်း သြေါ်န ိုင ပါတယ ။ 

က ိုယ တ ိုင  လ ိုက စမ ်းကကည ့်လ ိုက ပါ။ 

 
 

Toolbar သတွက ို Drag ဆွ ပပ ်း သရ ွေ့လ ိုို့ရတယ ။ အခပင က ို ဆွ ထိုတ ပပ ်း float လိုပ ြ ိုင ်းထ ်း လ ိုို့ရတယ ။ စမ ်းကကည ့်န ိုင ပါတယ ။ 

အသခြြ  သလ့်က င ့်ြန ်းသတွ အတွက  မရှ မခြစ  အ  ို်းခပြုရန  ြွင ့်ထ ်းရမယ ့် Toolbar သတွကသတ ့် File, Manage 

Layers, Layers, Browser, Map Navigation, Attribute စ ည တ ိုို့ ခြစ ပါတယ ။ မပွင ့်သ ်းရင  သ ြ  သအ င  

ြွင ့်ထ ်းသပ်းလ ိုက ပါ။ ၎င ်းတ ိုို့ရ ွေ့ အလိုပ လိုပ ပ ိုက ို နမူန အ ်းခြင ့် သအ က မှ  သြေါ်ခပထ ်းပါတယ ။ လက သတွွေ့ 

တကယ   ို်းလ ိုက တ ့် အြါက ရင  လွယ လွယ သလ်းန ို့ ပ ို သ  သပါက ပါမယ ။ 

File toolbar က QGIS project သတွက ို ြွင ့်ြ ိုို့ ပ တ ြ ိုို့၊   မ ်းြ ိုို့   ို်းတယ ။ Menu bar ရ ွေ့ 

Project menu သအ က က Tool သတွန ို့ တူတပူါပ ။  

Manage 

Layers toolbar က ို layer အမ  ြု်းအစ ်း အမ  ြု်းမ  ြု်းက ို 

ြွင ့်ြ ိုို့ အတွက   ို်းတယ ။ 

 Browser toolbar က GIS ြ ိုင သတွက ို browse လိုပ ကကည ့်ရန  အတွက    ို်းတယ ။ Browser ကသနတဆင ့် 

layer ရ ွေ့ Property က ို ကကည ့်လ ိုို့ရတယ ။ layer သတွက ို import/add လိုပ လ ိုို့ ရတယ ။ 
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Layers toolbar က import လိုပ ထ ်းတ ့် ြ ိုင မ  ်းနှင ့် ၎င ်းတ ိုို့၏ Map Legend သတွ အတွက    ို်းပါတယ ။ 

လက သတွွေ့လိုပ ခပတ ့်အြါက ရင  လွယ လွယ န ို့  သ  သပါက လ ပါလ မ ့်မယ ။ 

Map Navigation toolbar 

ကသတ ့် သခမပ ိုက ို ြ  ွေ့ပပ ်း ကကည ့်ြ ိုို့၊ 

ြ  ြုွေ့ပပ ်း ကကည ့်ြ ိုို့၊ ခမင ကွင ်းက ို 

အထက သအ က   ယ ည  တွန ်း သရ ွေ့ကကည ့်ြ ိုို့ အတွက    ို်းပါတယ ။  

Attribute toolbar ကသတ ့် layer သတွရ ွေ့ 

feature က ို identify လိုပ ြ ိုို့၊ layer ရ ွေ့ 

Attribute table သတွက ို ကကည ့်ြ ိုို့၊ 

feature က ို select လိုပ ြ ိုို့အတွက    ို်းပါတယ ။ 

က န တ ့် Tool သတွက ို အလ င ်း င ့် လ ို သန က မှ ထပ ပပ ်း မ တ ဆက သပ်းပါမယ ။ 

QGIS Setting and Configuration မ  ်းက ို ခပင ဆင ခြင ်း 

ဒ အြန ်းအတွက  လိုပ သဆ င ြ က ။ Software က ို မ မ ခပသစြ င တ ့် အတ ိုင ်း Setting သတွက ို ခပင ထ ်းရပါမယ ။ 

ထ ို  ိုို့ခပင ဆင ရန  Menu bar > Settings > Options > က ိုြွင ့်ပပ ်း CRS tab က ို click လိုပ ပါ အ ဒ မှ “CRS ဆ ိုတ  Coordinate 

Reference System” က ို သခပ တ ပါ။ 

 
CRS for Project တွင  Use CRS from first layer added နှင့်  Use a default CRS Project ဟိုနှစ မ  ြု်းရှ ပါ ည ။ 

Project အ စ ြန တ ်းသ  အြါတွင  Use CRS from first layer added နှင့်  Use a default CRS က ိုတစ ြို သရ ်းသပ်းရပါမည ။ 

Use CRS from first layer added က ိုသရ ်းလျှင  ပထမထည ့်လ ိုက သ   layer ၏ CRS က ိုအ  ို်းခပြုမည ခြစ  ည ။  Use a 

default CRS က ို select လိုပ ထ ်းပါက မ မ  သပေါ်သစလ ိုသ   CRS က ို CRS box တွင  သရ ်းသပ်းရပါမည ။ ယြို project တွင  Use 

CRS from first layer added က ိုသရ ်းထ ်းပါ။ 

CRS for layers  ည  လိုပ သဆ င မှုအ စ က ိုြန တ ်းရန    ိုို့မဟိုတ  CRS မပါ   layer တစ ြိုြွင့် သ  အြါ 

လိုပ သဆ င ရန   တ မှတ န ိုင  ည ။ ယြို project တွင  Prompt for CRS က ိုသရ ်းထ ်းပါ။ ပပ ်းလျှင  OK က ို click လိုပ ပါ။ 

သန က တစ ဆင့်  Menu bar > Project Properties က ိုြွင ့်ပပ ်း သပေါ်လ သ   Property Window တွင  CRS tab က ို 

click လိုပ ပါ။ Predefined Coordinate Reference System တွင  မ မ  Display view တွင  ခပလ ိုသ   CRS က ိုသရ ်း န ိုင  ည ။ 

ယြို Project တွင  EPSG:4326 က ိုသရ ်းပါ။ Display view တွင  latitude/ Longitude ခြင့်  ခပရန အတွက  ခြစ  ည ။ 
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EPSG ဆ ိုတ  projection system က ိုသြေါ်ခပတ ့် စနစ တစ ြိုခြစ ပပ ်း European Petroleum Survey Group က စတင  

 တ မှတ အ  ို်းခပြုထ ်းတ ့်စနစ က ို သြေါ်သဝေါ်ထ ်းတ ပါ။ 

QGIS တွင  GIS Layer မ  ်းခြင့် စတင သလ့်လ ခြင ်း 

ယြိုသလ့်က င့် ြန ်းတွင  အ  ို်းခပြုြ ိုို့ရန အတွက  လူ  ို်းမ  ်းတ ့် ESRI Shapefile အမ  ြု်းအစ ်း ခြစ တ ့် GIS ြ ိုင မ  ်းက ို 

အဓ က အ  ို်းခပြု ွ ်းပါမည ။ ဒ  shapefile အမ  ြု်းအစ ်းမှ  GIS သဒတ  တစ ြိုက ို အနည ်းဆ ို်း ြ ိုင   ို်းြိုန ို့ ြွ ွေ့စည ်းထ ်း ပါတယ ။ 

ြ ိုင န မည သတွရ ွေ့ သန က မှ  extension ၃ မ  ြု်းန ို့ ြွ ခြ ်းပပ ်း   ်းခြ ်းစ    မ ်းထ ်းတယ ။  

1. .shp  ြ ိုင ထ မှ  Geometry သတွပါဝင တယ ။  

2. .dbf  ြ ိုင ထ မှ  Attribute သတွပါဝင တ ့် database ြ ိုင ခြစ တယ ။ 

3. .shx  ြ ိုင ထ မှ  index သတွ ပါရှ တယ ။ 

အြ  ြုွေ့မှ  Projection က ို သြေါ်ခပတ ့် .prj ြ ိုင  တစ ြို ထပ ပပ ်း ပါဝင သနပါလ မ ့်မည ။ ထ ိုို့သကက င ့် shapefile မ  ်းက ို ကူ်းယူခြင ်း 

ခပြုလိုပ ြ င ပါက ထ ိုြ ိုင မ  ်း အ ်းလ ို်းက ို အစ ိုလ ိုက  ကူ်းယူပါမှ ခပည ့်စ ိုသ   GIS shapefile ြ ိုင  တစ ြို ခြစ ပါမည ။ Shapefile 

အသကက င ်း အသ ်းစ တ  ထပ   ြ င ရင  ESRI ကထိုတ တ ့် shapefile.pdf စ တမ ်းမှ  ဆက ပပ ်း သလ့်လ န ိုင ပါတယ ။  

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf 

 

GIS data layer မ  ်းက ို QGIS Project ထ   ိုို့ စတင  Import ခပြုလိုပ ခြင ်း 

QGIS Project Window ထ   ိုို့ Data မ  ်းထည့်  ွင ်းရန  နည ်းလမ ်းမ  ်းမှ  menu bar တွင ရှ သ   Layer > Add Layer, 

Manage layer Toolbar မ ှAdd layer, Browser panel မှ မ မ ထည့်  ွင ်းလ ိုသ   layer က ို drag လိုပ ပပ ်း layer window 

ထ တွင  drop ခပြုလိုပ ၍လည ်းထည့် န ိုင  ည ။ File explorer မှလည ်း မ မ ထည့်  ွင ်းလ ိုသ   layer က ို drag လိုပ ပပ ်း layer 

window ထ တွင  drop ခပြုလိုပ ၍လည ်းထည့် န ိုင  ည ။ 

ယြိုသလ့်က င့် ြန ်းတွင  menu bar မ ှadd vector က ို  ို်းပပ ်း စတင သလ့်လ ကကည့် ပါမည ။ 

Menu bar ကသန Layer > Add Vector Layers က ိုနှ ပ ပါ။ Source type အတွက  File က ို သရ ်းထ ်းပပ ်း Browse က ို နှ ပ လ ိုက ပါ။ 

 
 

D:\MIMU_TrainingData\Vector Data\World Data ထ က ကမ္ ့်န ိုင င မ  ်းြ ိုင  ခြစ  ည ့် ne_10m_admin_0_countries.shp 

က ို သရ ်းသပ်းပပ ်း Open က ို နှ ပ လ ိုက ပါ။ (မ မ ၏ computer ထ က shapefile မ  ်း   မ ်းထ ်းသ   သနရ က ို ညွှန ခပသပ်းရပါမည ။) 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
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Add vector layer ဆ ခပန သရ က လ ပပ ်း Source dataset မှ  က ိုယ သရ ်းသပ်းထ ်းတ ့် ြ ိုင န မည  သပေါ်သနမည ။ သအ က န ်းမှ  

ရှ တ ့် add button က ို ဆက နှ ပ လ ိုက ပါက အ ဒ  ြ ိုင က ို map view ထ   ိုို့ import လိုပ ပပ ်း  ်း ခြစ မည ။

 

QGIS ထ မှ  ြွင ့်ြတ န ိုင တ ့် ြ ိုင အမ  ြု်းအစ ်းမ  ်း 

QGIS software ကသန ြွင ့်န ိုင တ ့် ြ ိုင အမ  ြု်းအစ ်း သတွကသတ ့် GDAL/OGR driver သတွက support လိုပ တ ့် Raster နှင ့် 

Vector ြ ိုင  အမ  ြု်းအစ ်းမ  ်း၊ Spatial database မ  ်းမှ သဒတ မ  ်း၊ OGCWeb Service မ  ်းမှ သဒတ မ  ်း၊ non-spatial 

tabular data မ  ်း စ ည တ ိုို့ခြင ့် အစ ိုအလင  ပါဝင ပါ ည ။ 
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QGIS s up ports  Da tase t 

• Raster datasets – using GDAL Library (>100 raster formats) 

E.g. Arc/Info Binary Grid, Arc/Info ASCII Grid,GeoTIFF, Erdas Imagine 

• Vector datasets – using OGRLibrary (>60 vector formats) 

E.g. ESRI shape files, MapInfo MIF (interchange format), MapInfo TAB (native format) စ ည ့် 

အမ  ြု်းအစ ်းတ ိုို့က ို ြွင ့်၍လည ်း process လိုပ န ိုင ပါတယ ။  

ဒါဟ  QGIS ထ က ို File Import လိုပ န ိုင တ ့် အမ  ြု်းအစ ်းထ က တစ ြ  ြုွေ့သပါ ့်။ ဒ ခပင့်    သတွ ြွင ့်ကကည ့်လ ိုို့ ရသ ်း လ ။ 

Database file, Web Map Service, Flat file စ ည တ ိုို့က ိုလည ်း ြွင ့်လ ိုို့ ရန ိုင ပါတယ ။ 

 

Map Navigation tool bar က ိုအ  ို်းခပြုခြင ်း 

Map Navigation tool bar က ို  ို်းပပ ်း သခမပ ိုက ို ြ  ြုွေ့၊ ြ  ွေ့၊ သရ ွေ့ (Pan, Zoom) လိုပ ကစ ်းကကည ့်လ ိုက ပါ။ သခမပ ိုသပေါ် 

mouse တင ပပ ်း mouse ရ ွေ့ အလယ   ်းက ို သရှွေ့  ိုို့ သန က   ိုို့ တွန ်းလ မ ့်ကကည ့်လ ိုက ပါ။ Pan map tool န ို့သရ ွေ့ပပ ်း ခမန မ န ိုင င က ို 

ရှ ကကည ့်ပါ၊ Zoom က ို  ို်းပပ ်း map view မှ  သခမပ ိုက ိုအခပည ့် သပေါ်သနသအ င  ြ  န ည  က  ဆွ ြ  ွေ့ကကည ့်လ ိုက ပါ။ 

Browser Toolbar က ို ြွင ့်ထ ်းသပ်းပါ။  ယ  က  side bar မှ  သပေါ်လ ပါလ မ ့်မယ ။ Browser tab ကသန GIS 

ြ ိုင သတွထည ့်ထ ်းတ ့် D:\MIMU_TrainingData\Vector Data\World Data က ို ွ ်းပါ။ ပပ ်းသန က  ne_10m_roads.shp ဆ ိုတ ့် 

ြ ိုင သပေါ်က ို Right-click တင ပပ ်း၊ Add Layer က ိုနှ ပ သပ်းလ ိုက ခြင ်းအ ်းခြင ့် QGIS map project ထ   ိုို့ သန က ထပ  layer တစ ြို 

ထပ ထည ့်သပ်းလ ိုက ပါ။ 

World Cities ြ ိုင ခြစ  ည ့် ne_10m_populated_places.shp က ို map view ထ   ိုို့ Window ရ ွေ့ file explorer မှ 

Folder view/file view မ ှfile က ို Drag ဆွ ပပ ်း ထည ့်သပ်းလ ိုက ပါ။ 

 

QGIS project ထ က Layer တစ ြိုက ို အြငွ ့်၊ အပ တ  ခပြုလိုပ ခြင ်း 

Layer pane ထ က Layer တစ ြိုက ို အြွင ့်၊ အပ တ  ခပြုလိုပ ြ င ပါက 

ြွင ့်ပ တ လိုပ ြ င တ ့် Layer အမည ရ ွေ့  ယ  က  အစန ်းက အမှန ခြစ က ို တစ ြ က စ  

နှ ပ သပ်းပါက အ ဒ  Layer က ို Turn On/Off ြွင ့်ခြင ်း၊ ပ တ ခြင ်း ခပြုလိုပ န ိုင  ည ။ 

 

Layer မ  ်းက ို အထက သအ က  အစ အစဉ  သခပ င ်းခြင ်း 

Layer အမည ရ ွေ့ အသပေါ်က ိုmouse န ို့ Drag ဆွ ပပ ်း အထက  

သအ က  သရ ွေ့ပပ ်း စ သပ်းလ ိုို့ ရတယ ။ Layer pane ထ တွင ရှ  ည ့် Layer 

တစ ြို၏ အမည သပေါ်တွင  select လိုပ ထ ်းပပ ်း အထက ၊ သအ က   ိုို့ Drag 

လိုပ က  ဆွ  ခြင ်းအ ်းခြင ့် layer မ  ်းက ို မ မ တ ိုို့ လ ိုအပ သ   

အစ အစဉ အတ ိုင ်း သခပ င ်းလ န ိုင ပါ ည ။ 
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ဤ  ိုို့ သရ ွေ့သပ်းခြင ်းအ ်းခြင ့် သခမပ ိုသပေါ် မှ လည ်း layer မ  ်း အထက သအ က  လ ိုက ပပ ်း သခပ င ်း ွ ်းပါလ မ ့်မယ ။ 

အမ  ်းအ ်းခြင ့် Point, Line တ ိုို့က ို Polygon ရ ွေ့အသပေါ်မှ  Overlay တင ထ ်းပပ ်း   ို်းသလ့်ရှ တယ ။ အ ဒါမှ အပ တ  ခြစ သနတ ့် 

Polygon က က န တ ့် Point ၊ Line သတွက ို မြ ို်းသတ ့် ူ်းသပါ ့်။ 

န ိုင င  အသပေါ်မှ  က ်းလမ ်း၊ က ်းလမ ်း အသပေါ်မှ  ပမ ြုွေ့ စ ည ့် အစ အစဉ  အတ ိုင ်း ထ ်းပပ ်း စ သပ်းလ ိုက ပါ။ 

သအ က ကအလွှ သတွက ို ခမင ြ င ရင သတ ့် Layer Transparency န ို့ သြ က ပပ ်း ခပလ ိုို့ရန ိုင တယ ။ 

 

Attribute tool က ိုအ  ို်းခပြုခြင ်း 

 

Attribute tool က ို ြွင ့်ထ ်းပပ ်း၊ Identify က ို  ို်း၍ သခမပ ို၏ တစ သနရ သပေါ် တွင  Click လိုပ ကကည ့်လ ိုက ပါ။ ထ ို feature 

နငှ ့်  က ဆ ိုင သ   Attribute အြ က အလက မ  ်းက ို သတွွေ့ရပါမည ။ တစ ြိုပပ ်း တစ ြို သခပ င ်း၍ စမ ်းကကည ့်လ ိုက ပါ။ 

Feature selection tool က ိုအ  ို်းခပြု၍ feature မ  ်းက ို select လိုပ န ိုင  ည ။ feature မ  ်းက ို သရ ်းရန  

မ မ အ  ို်းခပြုလ ိုသ   tool က ို သရ ်းြ ယ ရန  လ ိုအပ  ည ။ feature selection tools 

မ  ်းက ို သလ့်လ ကကည့် ပါ။  

Select features by area or single click က ိုသရ ်းပပ ်း feature သပေါ်တွင  click 

လိုပ ကကည့် ပါ။ click လိုပ လ ိုက သ   feature  ည  

အဝါသရ င  သရ ်းြ ယ  ွ ်း ည  က ိုသတွွေ့န ိုင  ည ။ 

Select feature tool  ည  Mouse ခြင့်  feature 

တစ ြို   ိုို့မဟိုတ  တစ ြိုထက ပ ိုသ   feature မ  ်းက ိုသရ ်းရန  

အ  ို်းခပြု ည ။ 

 

Select f eat ure usi ng expre ss ion tool က  ိုအ သ ိုုံးပ ြုပ  ုံး  

attri bute t abl e က  ို select လို ် ပြ င်ုံး   

Select feature using expression tool  ည  attribute table က ိုအသခြြ ပပ ်း သရ ်းြ ယ ခြင ်းခြစ  ည ။ 

 တ ခပြုရန မှ  attributr table နှင့်  map canvas တွင ရှ သ   feature  ည  အြ က အလက တစ ြိုတည ်းခြစ  ည ။  င  

attribute table မ ှfeature တစ ြိုက ို select လိုပ လျှင  map canvas တွင လည ်း select ခြစ သနပါမည ။ 

Attribute table က ိုအသခြြ ပပ ်း select လိုပ ရန  layer panel တွင ရှ သ   ne_10m_admin_0_countries layer က ို 

select လိုပ ထ ်းပါ။ select feature using an expression button က ို click လိုပ ပါ။ 

 

ယြိုသလ့်က င့် ြန ်းတွင  လူဦ်းသရ  န ်းတစ ရ နှင့် အထက ရှ သ   န ိုင င မ  ်းက ို သရ ်းြ ယ ရန ခြစ  ည ။ 

ထ ို  ိုို့သရ ်းြ ယ ရန ။ Select by Expression window မ ှ

field and value က ို ခြနို့ ထိုတ လ ိုက ပါ။ ထ ိုမှတစ ဆင့်  

pop_est က ို double click လိုပ လ ိုက သ  အြါ 

expression section ၏သအ က တွင  pop_est 

သပေါ်လ  ည က ိုသတွွေ့ရမည ။ field value 

မ  ်းမသ ြ  လျှင  dataset အတွင ်းမှ unique value 

မ  ်းက ိုသတွွေ့န ိုင ရန  all unique button က ိုနှ ပ ပါ။ 

သအ က တွင  unique value မ  ်းက ိုသတွွေ့ရမည ။ 

ထ ိုအထ မှ မ မ လ ိုသ   data က ို double click 

လိုပ ၍ထည့် န ိုင  လ ို  “ > 1000000 “  ရ ိုက ထည့် ပါ။ 

expression section တွင   
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 "pop_ est"  > 10 000 000 0 ခပထ ်း ည့် အတ ိုင ်း သတွွေ့ရမည ။ ပပ ်းလျှင  select feature က ို click လိုပ လ ိုက ပါ။ လူဦ်းသရ 

 န ်းတစ ရ နှင့် အထက ရှ သ  န ိုင င မ  ်း  သရ ထ ်း ည က ို သတွွေ့ရမည ။ 

 

Exercise: ne_10m_populated_places layer မ ှန ိုင င ပမ ြုွေ့သတ  မ  ်းနှင့်  လူဦ်းသရ ၁၀ န ်းအထက ရှ သ   ပမ ြုွေ့မ  ်းက ို သရ ်းပါ။ 

Layers tab ထ ရှ  Layer အမည တစ ြိုြို သပေါ်က ို click နှ ပ က  select လိုပ သပ်းထ ်းပပ ်း Attribute tool ထ က Open 

Attribute Table က ို click တစ ြ က  နှ ပ လ ိုက ပါ။ ထ ို layer အတွက  Attribute table သပေါ်လ ပါလ မ ့်မည ။ ထ ိုဇယ ်းက ို 

စူ်းစမ ်းသလ့်လ  ကကည ့်ပါ။ 

အခြ ်းသ   layer အတွက  Attribute မ  ်းက ို အထက ပါနည ်းတူ Attribute ဇယ ်းမ  ်းက ို စူ်းစမ ်း 

သလ့်လ ကကည ့်လ ိုက ပါ။ 

Attribute table ပွင့် လ သ  အြါတွင လည ်း attribute table နှင့်  က ဆ ိုင သ   tools မ  ်းက ိုလည ်း 

သတွွေ့ရမည ခြစ  ည ။  

 


